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The user interface in AutoCAD LT® 2009 
software has undergone a major renovation. 
You are going to love how quickly you can 
navigate to your favorite commands while 
still maintaining plenty of room for your 
drawing. 

Right off the bat you will notice that the 
default model space background color has 
changed to off-white, making it easy for 
layer colors to be consistent in both model 
space and paper space.

New Quick Access Toolbar
In the upper-left corner of the screen is the 
powerful new Quick Access toolbar. Here 
you will find the frequently used New, Open, 
Save, Plot, Undo, and Redo commands. 

 
In addition, you can easily add your own 
favorites. Right-click and choose Customize 
Quick Access toolbar and then drag your 
favorite commands to personalize it for 
maximum productivity. A right-click menu 
option will restore the traditional menu bar 
as well.

Menu Browser
In the upper-left corner you will find the 
new Menu Browser button. Here are all the 
menus that used to lie across the top of your 
screen listed vertically for easy access. 
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Use the new Search tool in the upper-right 
corner of the menu browser to quickly 
search for any commands you need help 
finding. Behind the scenes, AutoCAD LT 
searches the CUI file to find all matches. 
Double-click any listed item to launch the 
associated command. 

The menu browser also provides access to 
recent or open documents (with preview 
icons if you choose). You can display them 
in an ordered list or group them by date or 
file type for added convenience. Move the 
cursor over any drawing name to display 
a preview image and other document 
information. You can control the length  
of this list in the Options dialog box.

Use the Recent Actions option to view and 
execute commands recently accessed from 
the menu browser.

Pin Important Drawings and Actions
Here is a favorite: The shortcut menu in the 
menu browser lets you pin a drawing file so it 
won’t fall off the list. You can also pin actions 
you use over and over for quick access.
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InfoCenter
You will find the new front-and-center 
InfoCenter a quick means to search for help 
information. Just click the arrow to open or 
close the search field.

The Ribbon
The ribbon is new to AutoCAD LT, but with 
a little practice you will quickly see the 
benefits. The ribbon consists of tabs and 
panels. Each tab contains multiple panels, 
and each panel contains multiple tools. 
These are completely customizable in the 
CUI—just as your existing toolbars are. 

You can anchor them to the side of the 
screen much like the Dashboard or turn 
them off for more screen real estate. You 
can easily reorganize the panels by dragging 

and even tearing a panel off the ribbon to 
create a floating panel. You get to set the 
ribbon up to work the way you do. Lock 
them all into place by using the Lock button 
on the status bar. And, of course, you can 
always switch back to the “AutoCAD LT 
Classic” workspace while you familiarize 
yourself with this new interface.

Status Bar
The status bar has been updated to include 
some new, powerful tools and improve 
efficiency. You can choose to view text 
or icons for the standard settings, such 
as Osnap, Grid, and Dynamic Input. The 
new interface makes it easier to tell which 
settings are on (much appreciated!).

Right-clicking many of these options (such 
as Polar or Osnap) also enables you to make 
quick work of changing the settings (thus 
saving you an extra click).

You will find a variety of tools on the status 
bar that we’ll cover later in more detail. 
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Tooltips
Tooltips have been expanded to provide 
more information as you need it. The longer 
you hover the cursor over a tool, the more 
information appears. (You can control this 
feature in more detail on the Display tab in 
the Options dialog box.)

Hidden Message Settings
Throughout the application, warning 
messages have been updated to provide 
more help. Should you decide to turn them 
off, they become hidden messages. Control 
the display of these messages on the 
Systems tab in the Options dialog box.

U
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Following is a graphic to help you decipher 
the new icons (you can’t change these to 
text). Notice that Workspace has been 
moved down to the status bar (saving more 
room) and that Viewport and Annotation 
have been combined to keep them in sync. 

 Check out the new Hide XREF Scales 
option added to the VP Scale list.

Layout Tab Improvements
•	 Rename a layout by double-clicking the 

Layout tab. 
•	 Reorder layouts with a simple drag- 

and-drop.
•	� Layout tabs are off by default.
•	 Use the Ctrl and Shift keys to select 

multiple layouts for dragging and 
dropping.

•	 Hold down Ctrl while dragging to create  
a copy.
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Check out the fantastic viewing tools added 
in AutoCAD LT 2009.

Quick View Layouts
The new Quick View Layouts tool on the 
status bar displays a row of layout images. 
This visual display makes it easier to 
navigate to the correct layout. Too many 
layouts to fit on your screen? No problem—
just move your cursor past the edge of the 
image strip to view additional layouts. 

You can rename layouts by double-clicking 
the layout name in Quick View (helpful if 
you are not displaying layout tabs).

 Right-clicking any layout displays the 
standard shortcut menu with a fabulous 
new Export Layout to Model option.

Use the Quick View control panel to close 
and publish all layouts, create a new layout, 
or pin your Quick View Layouts on the 
screen until you decide to close them.

 Use the icons in the upper corners of 
each Quick View Layout for speedy printing 
and publishing. 

Quick View Drawings
Also located on the status bar, Quick View 
Drawings displays a row of your open 
drawings. You also have easy access to the 
layouts in each of the drawings.
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SteeringWheels Feature
The new SteeringWheels™ view control 
makes it easy to zoom and pan. You can grab 
the new SteeringWheels feature from the 
status bar or by entering the word WHEEL. 
The SteeringWheels control follows the 
cursor as you move it so it is always handy. 
The Rewind option is similar to a visual 
zoom previous. 

Geographic Location
You can now define the geographic 
location of a drawing by importing location 
information from a KML or KMZ file or 
from the Google Earth™ mapping service 
application. GEOMARKERVISIBILITY 
controls the visibility of the geographic 
marker.

 Use the Ctrl key while rolling the 
mouse wheel to increase or decrease the 
size of the drawing preview image.

Use the control panel to pin open the Quick 
View Drawings images, start a new drawing, 
open an existing one, or close Quick View 
Drawings.

 You can quickly save or close a drawing 
(not just the current drawing) by using the 
buttons in the upper corners of the drawing 
image.
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Object and Layer Properties

See how new object and layer tools in 
AutoCAD LT 2009 can make your dreams 
come true. 

Quick Properties
The new Quick Properties tool enables you 
to view and modify object properties in 
place, without having to go to the Properties 
palette. You can turn Quick Properties (QP) 
on or off from the status bar. After turning 
the feature on, simply select an object and 
the properties display for editing. You can 
control which properties are displayed for 
each object in the CUI (for speedy access 
select the Customize button in QP). 
 

The new Quick Properties tab in the 
Drafting Settings dialog box provides 
additional control.

Layer Management
The Layer Properties Manager is now 
modeless so you can keep it displayed 
as you use other commands. That means 
you can dock, autohide, or anchor it just 
like your other tool palettes. And it is now 
dynamic—any changes you make in the 
Layer Properties Manager are instantly 
applied to the drawing (no more “Apply”). 
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If you have ever had a hard time viewing 
the layer name column when you slide over 
to the right side of the column, you will be 
happy to know that now you can freeze 
or unfreeze columns. Optimize one or all 
columns to keep content from truncating, or 
maximize one or all columns to help ensure 
that no headers are truncated. If you need 
more real estate in the dialog box, you can 
now collapse the Filters pane.

The new Layer panel on the ribbon is filled 
with all types of layering controls—be sure 
to give it a try.

 A new option to combine layer 
property changes for Undo/Redo can be 
found in the User Preferences tab of the 
Options dialog box.

Customize Layer Manager
Control the display order of the layer 
property columns by dragging the column 
headings—put your favorites on the left 
for easy access. Too many columns? Turn 
off the ones you aren’t using by choosing 
Customize from the shortcut menu.

O
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Freezing a Layer in All Viewports
The shortcut menu enables you to create 
a new layer that is frozen in all viewports, 
a function that is also available as a new 
button. Here you also find additional 
controls to freeze or unfreeze the selected 
layer or layers in all viewports. 
 

Renaming Layers
AutoCAD LT 2009 software provides three 
ways to rename a layer: double-click the 
layer name, select a layer and press F2, or 
choose Rename from the shortcut menu.

Layer Properties per Viewport
How often have you wished you could assign 
layer properties per viewport? Wish granted. 
No more tedium duplicating geometry on 
separate layers and flipping the layers on 
and off per viewport. Now you can double-
click in a viewport and assign a specific color, 
linetype, lineweight, and plot style per layer 
that affect only the current viewport. 

Remove these viewport overrides 
from the right-click menu. Use 
VPLAYEROVERRIDESMODE to temporarily 
ignore the overrides for viewing or plotting. 
These overrides affect only those objects 
with the bylayer attribute. 

 Use the new SETBYLAYER command to 
quickly change objects to bylayer, including 
those within blocks and nested blocks.

Direct Access to the Layer States Manager
The LAYERSTATE command (LAS alias) 
provides access to the Layer State Manager 
from the command prompt (also on the 
Layer panel of the ribbon). Use the Import 
option to bring in layer states directly from 
DWG,™ DWT, or DWS files. Now you can 
also edit or view layer states from xrefs.
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Layer Evaluation Tool
The Settings button in the Layer Properties 
Manager enables you to turn on a layer 
evaluation tool. 

•	 The first time you save or plot, the current 
list of layers is stored for evaluation 
purposes.

•	 When new layers are added, an 
Unreconciled New Layers notification 
appears. Click the link to view the 
nonmatching layers.

•	 A new layer filter for unreconciled layers 
is automatically created.

•	 You can customize this process in the 
Layer Settings dialog box.

•	 Two system variables, LAYEREVAL and 
LAYERNOTIFY, can also be used to turn 
these features on or off.

Updated Layer Settings Dialog Box
Many layers settings have been moved to 
the Layer Settings dialog box, which can be 
found in the Layer Properties Manager.

O
bject and Layer Properties
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Annotation Scaling

If you have found getting the proper scale 
factors per viewport to be frustrating and 
confusing, then you will love annotative 
scaling. No longer do you need to create 
multiple sets of text and dimensions 
on multiple layers. Now you create one 
set of annotative objects (such as text, 
dimensions, multiple leaders, blocks, 
attributes, and hatches), indicate the desired 
actual plotted size, and it automatically 
displays at the correct size.

Controlling Annotation Scale
An annotative property can be assigned to 
objects such as text, dimensions, blocks, 
and hatches. Just create the object at the 
actual size you want it to plot and indicate 
the intended scale factor or factors. Any 
object with an annotative property can 
have one or more scales assigned to it (such 
as ¼”=1’ or 1:50). This capability makes it 
easy to display the same object in different 
viewports with varying scale factors. For 
example, the same text object could appear 
in one viewport that is scaled 1/8” = 1’, and 
another viewport at 1”=1’.
 

You can change an existing object to 
annotative using the Properties command. 

Redefining a style or definition to be 
annotative does not affect existing objects. 
Use the ANNOUPDATE command to update 
selected objects to match their style or 
definition (model space only).
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How can you tell whether an object is 
annotative just by looking at it? Drag your 
cursor over the object to see the annotative 
indicator.

 Set the annotative scale factor in 
model space to reflect the most prevalent 
scale factor in the drawing. 

For those objects that need to display at 
multiple scale factors, use the Properties 
palette to add scale factors. You can also 
use the OBJECTSCALE command. 

 It is faster to use the OBJECTSCALE 
command when dealing with different 
object types.

Annotative Controls on the Status Bar
•	 A Lock/Unlock Viewport button appears 

when a viewport is selected.
•	 Use the controls on the status bar to set 

the VP Scale and to sync the Annotation 
Scale (accessible only if the viewport is 
unlocked). 

•	 Only the annotative objects that have the 
same scale factor as the viewport appear 
in a viewport. Toggle the Annotation 
Visibility button to display annotative 
objects for all scales (even if they are 
not supported by the viewport’s current 
annotation scale).

 Use SCALELISTEDIT to customize the 
list of scales.

A
nnotation Scaling
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 If an annotative object disappears 
(and you don’t want it to), click the 
Automatically Add Scales to Annotative 
Objects button before changing the 
annotation scale. 

Backward Compatibility
An option on the Open and Save tab of the 
Options dialog box helps ensure that those 
who are not using AutoCAD LT 2009 can 
see your annotative objects. Each scale 
of the objects is saved as an independent 
object on its own layer. The layers are 
automatically frozen in the appropriate 
viewport.

 If you have a large quantity of 
annotative objects, you can speed things up 
by turning off the Maintain Visual Fidelity 
option. Be sure to turn it back on before you 
save the file to a previous version.

 Linetypes are automatically scaled 
by the viewport’s annotation scale. Disable 
this behavior with the MSLTSCALE setvar if 
needed.

A
nnotation Scaling
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Cool dimension features multiply the 
options and give you more control. 

New Multiple Leaders
The MLEADER command permits more 
control over leaders than ever before. Not 
only can you control the order of leader 
creation (head first, tail first, or content 
first), but you can also add multiple leader 
lines where needed.
 

Multiple Leader Style Manager
The MLEADERSTYLE command controls 
format and display options, just like 
dimension styles. Options include the 
following:
•	 Type of leader line (straight, spline,  

or none)
•	 Type of arrowhead
•	 Leader connection info
•	 Text information
•	 Assign a block (great for creating 

balloons)

 Use the shortcut menu to add leader 
lines. Use grips for speedy editing.

Aligning Leader Lines
Leaders not lining up properly? The Multiple 
Leader Align tool snaps leaders into place 
for you. You can even control the spacing 
between them.

Use the MLEADERCOLLECT command to 
combine multiple block-type leaders into a 
single multiple leader. 

A
nnotation Scaling
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Smart Dimension Break Command
The DIMBREAK command breaks dimension 
or extension lines where they intersect 
objects or other dimensions. The breaks 
automatically update if you move the 
intersecting objects—even if they no longer 
intersect. You can also use the Restore 
option to remove all breaks.

 

More Cool Dimension Features
•	 Create inspection dimensions with 

the Inspection Dimension tool 
(DIMINSPECT). 

•	 Add a jog to linear dimensions with the 
DIMJOGLINE command.

•	 Evenly space baseline dimensions with the 
DIMSPACE command.

•	 Place the dimension text outside the 
angle being measured with the updated 
Angular Dimension command.

•	 Dimension an arc beyond its endpoints 
with the updated diameter and radial 
dimension commands.

 

•	 The Tolerance alignment option in the 
Dimension Style dialog box enables you 
to align decimal separators or operational 
symbols.
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Use these handy tricks to buy yourself some 
time when working with text in AutoCAD LT 
2009.

Use ESC to Exit MTEXT
Now when you click Escape in the MTEXT 
editor, the software gives you a chance to 
save your text. Make this the default if you 
choose.

In-Place Spell Checking
Catch those spelling errors as they 
are happening in MTEXT. AutoCAD LT 
underlines in red those words that are not 
in the dictionary, and the right-click menu 
offers spelling suggestions. 

 

More Efficient Spell Checker
No need to select objects first. The updated 
spell checker searches the entire drawing 
by default. You can also specify the current 
space or specific objects if you prefer. When 
an error is found, AutoCAD LT now highlights 
and zooms to the word in the drawing.

The Check Spelling Settings dialog box 
enables you to customize the spell checker. 
You can choose to include dimension text, 
attributes, and xrefs, and set a variety of 
exclusions, such as capitalized words or 
words with numbers.

Text Step Savers
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Text Step Savers

MTEXT Column Wrap
Ever wish text would automatically wrap 
across multiple columns in wide areas of 
your drawing? Your wish has been granted 
with the dynamic columns option in the 
MTEXT command. Use grips along with the 
text formatting ruler to get the exact results 
you are after. 

More Control over Paragraphs
The MTEXT command gives you more 
control over paragraph alignment, 
indentations, and spacing. 
 

Create Attributes with Multiple Lines  
of Text
The new Multiple Lines option enables you to 
create attributes that support multiple lines, 
underlining, overlining, fields, and so forth. 
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Simplify your work with table improvements 
in AutoCAD LT 2009.

Bidirectional Excel Tables
Wouldn’t it be nice if you could bring a 
Microsoft® Excel® file into AutoCAD LT and 
truly link the file? If you could change the 
Excel file and have it update in AutoCAD LT, 
and vice versa? Good times are here, because 
now you can do exactly that. 

Just use the updated Paste Special com-
mand, choose AutoCAD Entities, and select 
Paste Link to insert the Excel spreadsheet 
into AutoCAD LT. This process creates a 
data link. Should any changes occur in the 
XLS file, you can use DATALINKUPDATE to 
refresh the table display. 

Create a Table from a Data Link
An option in the TABLE command also 
enables you to create a table from an Excel 
file. Just select all or part of the sheet.

 Use the DATALINK command to 
manage all of your various data links.

Retain Changes in Tables
Any changes you make to an AutoCAD LT 
table are retained, even if you update the 
table to reflect any changes in the Excel file.

Wrap Long Tables Across Multiple Rows
To wrap tables across rows, simply select the 
table and adjust it with grips or use the new 
Table Break tool in the Properties palette.

Create Incremental Data Fast
Auto-fill enables you to quickly increment 
data in cells by dragging, just as in Excel. 
You can also combine blocks and text in the 
same cell.

Table Step Savers
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Productivity Tips

Productivity Tips

These features can help you really boost 
your productivity.

Export Layout to Model Space
You can export all visible objects from the 
current layout to model space with the 
EXPORTLAYOUT command. 

 Objects that are outside the paper 
boundaries of the layout are also exported.

More Powerful Find and Replace
The FIND command now contains toggles 
to enable searching blocks and xrefs (along 
with many other additions). And FIND now 
zooms in on the found objects (so it’s no 
longer a mystery).
 

Speedy WBLOCKs
Should you decide to turn an existing block 
or dynamic block into a WBLOCK, it is easier 
than ever. Simply select the block, enter 
W for the WBLOCK command, and your 
selected block is ready to go.
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Updated Array Command
Now you can zoom and pan while 
previewing. 

Missing Printers Identified
Missing printers are now identified with a 
“Missing” prefix instead of a suffix—no more 
accidental truncation of that key piece of 
information.

Recover Drawings Along with Xrefs
Now you can run the recover process on a 
drawing and all the associated xrefs. Find 
this capability under Files>Drawing Utilities 
or use the RECOVERALL command.

ETRANSMIT Enhancements
You no longer need to save your drawing 
before executing the ETRANSMIT 
command. You will also find the handy 
Purge option in the Transmittal Setup dialog 
box to help ensure that you are sending 
nice, clean drawings.

Productivity Tips
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It’s always great when additional AutoCAD® 
functionality makes its way into AutoCAD 
LT. You’ll find that some big wish list requests 
have been granted in AutoCAD LT 2009!

Attach Raster Images
Now AutoCAD LT users can attach raster 
images in the same fashion they do an xref. 
This can be done in the External References 
palette with the new Attach Image option or 
by using the new IMAGEATTACH command. 
Simply select the desired image file as seen 
below:

After selecting an image, you’ll be asked 
for information similar to the XATTACH 
command, such as insertion point, scale, 
and rotation angle. You’ll also find that 
you can manage all of your images in the 
External References palette.

Edit Raster Images
Turn on the image frame for editing with the 
IMAGEFRAME system variable. 

 Set IMAGEFRAME to 2 so that the 
frame displays but doesn’t plot!

Clip your attached raster images to a 
polygonal or rectangular shape with the 
IMAGECLIP command. It’s easy to modify 
the clipped image with grips.

Adjust the brightness, contrast, and fade of 
the raster image with IMAGEADJUST.

If you find that your raster images 
are slowing your drawing, use the 
IMAGEQUALITY command. Set the  
value to Draft for speedy regeneration.
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Nonrectangular Viewports
Create nonrectangular viewports in 
the MVIEW command by selecting the 
Polygonal or Object option. Polygonal lets 
you select the points that make up the 
viewport boundary. The Object option lets 
you select an existing closed object created 
in paper space such as a circle or spline.

 You can also use a nonrectangular object to 
clip an existing viewport. Objects used for 
clipping can include a closed polyline, circle, 
spline, or ellipse.
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More Colors!
AutoCAD LT 2009 has expanded the color 
possibilities from the usual 256 colors to 
include True Color and Color Books. Now 
you can select a specific color from a variety 
of PANTONE® and RAL color books, making 
it easy to match up with real-world colors 
of actual materials. There are two new tabs 
in the Select Color dialog box. The True 
Color tab enables you to select the Hue, 
Saturation, and Luminence (HSL) or Red, 
Green, and Blue (RGB) levels. The Color 
Books tab displays a variety of PANTONE 
and RAL color books. You can even add 
additional color books in the Options dialog 
box (Files tab).

All those color possibilities will definitely 
make it easier for your clients to visualize 
your design intent. 
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Fields
One of the most powerful objects in 
AutoCAD, Fields are equivalent to “smart 
text” that updates automatically. Use 
field data for such things as dates, sheet 
numbers, and titles.

Select fields from a list of predefined  
fields. These fields can be inserted into  
text objects, attributes, or table cells.

There are three methods for inserting a field:

1.	Select the Insert Field option on the 
right-click menu when prompted for text 
in MTEXT, DTEXT, and ATTDEF. Some of 
these commands also have an Insert Field 
button.

2.	Press Ctrl+F when prompted for text in 
MTEXT, DTEXT, and ATTDEF.

3.	Execute the Field command (this will place 
the field as mtext).

Whichever route you take, simply select the 
field you wish to add. The FIELDDISPLAY 
system variable toggles the display of a gray 
background for field text (intended for easy 
recognition of Field text).

 Fields enable you to display object 
properties such as the area of a hatch, the 
length of a polyline or the diameter of a circle.

Editing Fields
Easily edit your fields by double-clicking. 

Updating Fields
By default, field values automatically update 
when you open, save, plot, eTransmit, or 
regenerate a drawing. You can suppress 
this automatic evaluation by setting the 
FIELDEVAL system variable. You can 
also use the UPDATEFIELD command to 
manually update.
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Sharing

Sharing your drawing information is 
important, and AutoCAD LT 2009 makes  
it even easier to do so.

Working with DGN Files
Now you can attach Bentley MicroStation® 
V7 and V8 DGN files to your AutoCAD LT 
drawings or export DWG files to V7 and V8 
DGN format using File>Export. Bring them 
in as externally referenced underlays with 
DGNATTACH using Insert>DGN Underlay. 
Clip the DGN from the shortcut menu 
(or use DGNCLIP) and use Properties to 
adjust contrast, fade, and monochrome (or 
DGNADJUST). 

Import V7/V8 DGN data with DGNIMPORT 
using File>Import. When importing, you see 
a dialog box that prompts for information 
regarding external DGN references, text 
nodes, and units to help you get the best 
results.

You can now control the layer visibility of 
attached DGN files by selecting the DGN 
Layer option from the shortcut menu. A 
handy mapping tool maps DGN levels, 

linestyles, lineweights, and colors to 
AutoCAD LT layers, linetypes, lineweights, 
and colors (and vice versa). Use the new 
DGNMAPPING command to set and save 
these settings.

DWG TrueView
•	 The software provides backward and 

forward conversion of DWG files from 
AutoCAD LT Release 14 to AutoCAD LT 
2008 using the conversion features of 
DWG TrueView™ 2009 software.

•	 Now anyone can view, publish, and plot 
DWG files with DWG TrueView. 

Sharing
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Download DWG TrueView for free* (and we 
all love free!) at www.autodesk.com/dwg.

 Use DWG TrueView to quickly apply a 
page setup to multiple layouts.

Autodesk Labs
Be sure to visit to visit Autodesk Labs to stay 
up and running on tomorrow’s technology. 
At labs.autodesk.com you can download 
(for free) many cool tools regardless of your 
discipline.

Autodesk Design Review
Make it easy for your colleagues who don’t 
use CAD. When you publish to DWF™ (or 
DWFx) format, your colleagues can use 
Autodesk® Design Review software to view, 
measure, mark up, and track changes to any 
design. 

•	 Designs published to DWFx format can 
be viewed natively in the Windows Vista® 
operating system (in addition to Design 
Review).

•	 Autodesk Design Review 2009 software 
enables you to search models and drawings 
for text, drawing, object properties, and 
other metadata in the DWF file.

•	 And you can now rotate any type of sheet 
or raster file before adding markups (so 
you don’t need to turn your monitor on its 
side anymore). 

The free* download is available at  
www.autodesk.com/designreview.

 Be sure to specify the resolution for 
vector and raster graphics when creating 
DWF files—it allows for much greater 
precision.

Sharing



28

*Free products are subject to the terms and conditions of the end-
user license agreement that accompanies download of the software. 

Autodesk, AutoCAD, AutoCAD LT, DWF, DWG, DWG TrueView, 
and SteeringWheels are registered trademarks or trademarks of 
Autodesk, Inc., in the USA and/or other countries. All other brand 
names, product names, or trademarks belong to their respective 
holders. Autodesk reserves the right to alter product offerings and 
specifications at any time without notice, and is not responsible for 
typographical or graphical errors that may appear in this document. 
© 2008 Autodesk, Inc. All rights reserved. 

Lynn Allen, Cadalyst columnist and worldwide 
Autodesk technical evangelist, speaks to more 
than 30,000 users each year. For the past 15 
years she has written a monthly column in 
Cadalyst magazine called “Circles and Lines” 
and is the voice behind Cadalyst’s “Tips and 
Tricks Tuesdays.” Lynn started using AutoCAD 
software with Release 1.4, over 20 years ago, 
and got her start by teaching at the corporate 
and collegiate level for 12 years. A sought-after 
public speaker with a unique comedic style, 
Lynn has served as the Autodesk University 
emcee for 10 years and is always one of the 
highest-rated speakers. Her latest book is en-
titled AutoCAD Professional Tips and Techniques. 

To purchase AutoCAD LT 2009 software, 
contact your Autodesk Authorized Reseller or 
visit www.autodesk.com/reseller to locate  
an authorized reseller near you.


